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Foreword

INCLINEO® s yet another innovative productintroduced to the market by PRUFTECHNIK.
It combines functions which until now were not available in one compact system
with an elegant design and simplicity of use. Its ergonomic design functionality in
operation together with manufacture from materials that are extremely light but
able to withstand harsh operating environments makes INCLINEO® a highly accurate
and easy to use measurement system. In operation the unit is able to be rotated
through 360° making measurement at any angular position possible. It is operated
using just 3 keys with a functional menu that offers the user all the required options
for measuring profiles and determining levelness and parallelism of surfaces. The
integrated Bluetooth wireless technology is used to transfer data via a flexible modern
common PC software platform for processing and display. INCLINEO® is appropriate
for the following applications:

Measurement on surfaces with any inclination
Level, flatness or parallelism of surfaces

Angularity measurements along edges and borders
Plumbness of vertical shafts

Parallelism of sloping surfaces

Perpendicularity of planes

v v v v v v w

Ideal for installation and service
INCLINEQ® is a suitable tool for most production industries.

If you have any suggestions for improvement or corrections (not just to this manual,
but also for hardware), please drop us a line. We would be glad to make improve-
ments wherever possible.

We look forward to hearing from you.

PRUFTECHNIK Condition Monitoring
Ismaning, Germany
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INCLINEO packages

INCLINEO standard

package ALI 18.000

The standard INCLINEO package ALl 18.000 constitutes the listed items:

ALl 18.201

ALl 13.620

ALl 18.500

ALl 18.501-150

ALl 18.502-150

ALl 13.620

ALl 18.501-150

ALl 18.502-150

INCLINEO inclinometer assembly without base

USB RF dongle

Three point mounting base

INCLINEO grooved mounting base for smooth
surfaces

INCLINEO prism-shaped mounting base for rolls

and shafts
ALl 18.200 comprises

ALl 18.201 and
ALl 18.500

g FroFTECHNIK

4 +0.0014

deg-ABS Filter: min
INCLINEO
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00621 0038

00739 1056

90022 (4 no.)

ALl 18.800

ALl 13.700 CD

ALl 9.182.G

ALl 9.183.G

00739 1056

90022

ALl 13.700 CD

Philips cross screwdriver

Allen key (3.0 mm) 006210038

Standard AA size batteries

INCLINEO standard case

ALIGNMENT CENTER CD

INCLINEO pocket guide

INCLINEO operating instructions

ALl 9.182.G
ALl 9.183.G

ALl 18.800
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Other INCLINEO packages

Other INCLINEO packages are listed below and details of their composition may be
obtained from your local PRUFTECHNIK Condition Monitoring representative.

INCLINEO package with grooved mounting base (150 mm) ALI 18.001
INCLINEO package with prism-shaped mounting base (150 mm) ALl 18.002
INCLINEO package with three-point mounting base ALl 18.003

Optional INCLINEO components

ALl 18.290 INCLINEO calibration certificate
ALl 18.400 INCLINEO USB converter

ALl 18.500-M INCLINEO magnetic foot

ALl 3.581-2 Receiver cable

%/K_/_J// \(((((% ALI 3.581-2




Safety notes

Intended use

INCLINEO is a package designed to be used in industrial environments only for
measuring inclination and angularity on surfaces, rolls and shafts. Care must be taken
to ensure that the system is not subjected to mechanical knocks. INCLINEO must
be operated only by properly trained personnel. No liability will be assumed when
components or operating procedures as described in this manual are altered without

permission of the manufacturer.

Safety symbols

The following symbols are used in this manual in order to draw the reader’s attention
to especially important text, such as that regarding possible sources of danger or
useful operating tips.

This symbol denotes general information and tips regarding operation of
INCLINEO.

This symbol denotes information which must be followed in order to avoid
damage to equipment.

This symbol denotes information which must be followed in order to avoid
personal injury.

The number within the red circle corresponds to the instruction with the same
number and must be followed exactly.

CE compliance and EMC
All INCLINEO components fulfil the EC Guidelines for electric devices and those
relating to electromagnetic compatibility (2004/108/EC).

IP classification
INCLINEO and related components are water and dust resistant (IP65). (dust-tight and
protected against immersion).
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Storage

When not in use, store INCLINEO in such a manner that the display lies in parallel
with the red handle and the mounting base. Also ensure that the display axis remains
horizontal within +/- 5°. INCLINEO should be stored at temperatures between 15°
and 30° C. These measures should prevent against premature damage of the high
precision electronic inclinometer.

Note regarding data storage
With any data processing software, data may be lost or altered under certain C@
circumstances. PRUFTECHNIK strongly recommends that you keep a backup or

printed records of all important data. Note

PRUFTECHNIK assumes no responsibility for data lost or altered as a result of

improper use, repairs, defects, battery replacement/failures or any other cause.

PRUFTECHNIK assumes no responsibility, directly or indirectly, for financial losses
or claims from third parties resulting from the use of this product and any of its
functions, such as loss or alteration of stored data.

Service and care

Although INCLINEO is essentially maintenance free, the calibration accuracy of the
system should be checked every six months as indicated by the calibration label (see
below) located on the back of the rotatable inclinometer assembly.

Component labelling
The labels shown below are to be found on INCLINEO.

Type

S. No.
|

2z
1
2
@
o
©
o
3
o
3
2

HW
C E www.pruftechnik.com

The above label is affixed on the The calibration label is affixed
back of INCLINEO and shows on the back of INCLINEO and
the part and serial number of shows the date of the next
the system and the hardware scheduled calibration.

version.



Getting started

Getting to know INCLINEO, the high precision inclinometer

Important parts of INCLINEO

e\

Rubber grip handle

Micrometer screw
for fine adjustment

Battery status LED

IS
TR

indicator

1 |— Bluetooth LED

g/ PROFTECHNIK a _
- 4 +0.0

deg-ABS mer min _

indicator

Display

Rotatable inclinometer
assembly

Operating keys

Measurement base

External
interfaces

Labeling

ON/OFF
switch

Locking screw

11
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Description of INCLINEO parts

>

Rubber grip handle — To improve flexibility for measurement, the handle may
be detached from the assembly and rotated through 180°. This is readily
achieved by undoing the two hex socket screws on the base of the handle.
The socket screws are loosened or fastened using the provided 3 mm allen
key.

Micrometer screw gauge — Used for fine adjustment during the set-up
procedure. It is recommended to try and have the red marking on the screw
gauge positioned in the middle of the slot.

Battery status LED indicator — This constitutes 3 LED bars to indicate the
INCLINEO battery capacity.

The 3 LED bars operate as a graph to indicate the battery capacity from 100%

where all three are lit continuously to low capacity of under 25% where only a
single LED bar blinks fast. In this case, the battery operating time is in a critical
phase and measurements should not be take.

Note

The operating time may vary significantly depending on the type of batteries
used. Normally, alkaline AA-size batteries are used.

Bluetooth LED indicator — Used to indicate whether the system’s wireless
communication is on or off. When wireless communication is turned on, the
Bluetooth LED bar blinks slowly.

Display — All set-up, measurement and menu items are shown on the display.
The display’s backlight may be turned on to illuminate the screen.

Rotatable inclinometer assembly — The assembly houses the high precision
inclinometer. By being rotatable, it provides the flexibility to measure virtually
any inclination.

Operating keys — The operating keys are used for a variety of functions which
include: calling up and cycling through menu items, turning the display
backlight on or off, freezing any indicated value.

Measurement base — The measurement base is changeable to suit the type of
surface being measured. Three different types of bases are available.

External interfaces — Three ports for direct connection to a PC or a sensor or
a measurement gauge are available on the back of INCLINEO. Presently, the
sensor and measurement gauge ports are dedicated to marine applications.
Battery compartment — The compartment is opened using a Phillips screw
driver. Remove the compartment to replace the 2 AA-size batteries.



»  The on/off switch is part of the battery compartment.

» Labelling — Two labels are affixed to the back of INCLINEO. One shows the
date when calibration is due and the other shows the article number, the
INCLINEO serial number and the version of the hardware.

> Inclinometer assembly locking lever — The lever is used to fasten the rotatable
assembly. The assembly is rotated only when the lever is loose. To lock the
assembly, the lever is turned to the left (as viewed from the side) with a small
amount of force. When the lever is in the “lock” position, the micrometer
screw gauge must never be turned.

Powering INCLINEO

INCLINEO is powered using 2 standard AA size alkaline batteries contained in the
battery compartment. It is recommended that both batteries be replaced at the same
time when only a single battery status LED bar blinks quickly.

Replacing batteries

Undo the two Phillips screws. With the screws loosened, hold and pull out the battery
compartment. The reverse procedure is used to reinstall the battery compartment.
Note the battery polarity when inserting them in the compartment.

13
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Understanding menu items

Always remember that the INCLINEO on/off switch is located on the back of the @
system.
Note
After turning INCLINEO on, the software version number appears on the display
followed by a value displaying the inclination in which the inclinometer finds itself in
the current state. The value is a relative measurement denoted by “REL".

4 +0.1481

dea - EEL Filter:min

Press i to reveal available INCLINEO menu items. Use [& or [ to cycle through the
main INCLINEO menu items. The following menu items are available:

Relative measurement

Absolute measurement

Filter

Units

Memory

Backlight

RF module

v v v v v v v v

Device info

Relative measurement
This is the first menu item that appears.

< Relative Meas =
+000.0000 deg

Pressing [l while in “Relative Meas” reveals the submenu items. Use [= or 5 to cycle
through the available submenu items. Press il to confirm selection of the currently
displayed submenu item.

F-'.ELEItiUE Meas Used to show the true inclina-
=< rEEEt = tion of the inclinometer



Used to set the displayed value

to zero

Used to edit the angular offset

value

Used to exit the “Relative

Meas” menu

The “Relative measurement” menu is exited by pressing with “exit” displayed.
The next menu item is accessed by pressing i to display the first menu item (Relative
Meas), followed by .

Absolute measurement
This is the next menu item that appears after pressing [E.

This menu item is used to set the absolute measurement mode. Readings taken after
this mode has been activated are absolute inclination values.

Type of filter
Pressing [ while in “Filter” reveals the submenu items. Use [E or [ to cycle through
the available submenu items. Press [if] to confirm selection of the currently displayed

submenu item.

When selected, readings acquire

an average smoothing

When selected, maximum

smoothing is applied to the

readings

15
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When selected, the filtering
process is turned off and no
smoothing is applied to the

reading

When selected, minimum
smoothing is applied to the

readings

Used to exit the “Filter” menu

The “Filter” menu is exited by pressing & with “exit” displayed. The next menu item
is accessed by pressing i to display the first menu item (Relative Meas), followed by

or [ repeatedly.

Measurement units
This menu item is used to select desired measurement unit.

Pressing i while in “Unit” reveals the submenu items. Use [&] or [ to cycle through
the available submenu items. Press [iffl to confirm selection of the currently displayed
submenu item.

Used to select the measurement unit “arcsecond”.
1 arcsecond = 1" = 1/60 of an arcminute = 1/3600 of

a degree

Used to select the measurement unit “rel” which is
based on the relative base length of the given surface.

The displayed value is a height.

Used to select the measurement unit “milliradian”.

1 milliradian = 0.001 radian [rad is a unit of angular

measure equal to the angle subtended at the centre of a
circle by an arc equal in length to the radius of the circle
=180 /1 =57.3° (app.)]



Used to select the measurement unit “microradian” =
1/1000 of a milliradian

Used to select measurement unit “degrees” up to 4

decimal places

Used to select measurement unit “degrees” up to 3

decimal places

Used to select the measurement unit “gon”.
1 gon ==/ 200 radian. Gon is also called grade or
new degree. Every new degree is divided into 100 new

minutes and every new minute into 100 new seconds

Used to select the measurement unit “millimetre /

metre”

Used to select the measurement unit “mils / inch”

Used to select the measurement unit “inch / 10 inches”

Used to select the measurement unit “degrees - minutes

- seconds”

Used to exit the “Unit” menu

17
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The “Unit” menu is exited by pressing i with “exit” displayed. The next menu item
is accessed by pressing i to display the first menu item (Relative Meas), followed by
or [ repeatedly.

Memory
This menu item is used to save measurements taken.

= M 2maoar 'yl' = This display shows that 12 of the available 999 memory
UEEQE' ':'12 {QE?} slots have data stored in them.

Pressing while in “Memory” reveals the submenu items. Use [ or 5] to cycle
through the available submenu items.

M 2mor 'I_,.,I' Used when measurement data is to be stored manually
= manual =

To store measurement data manually, press with the submenu item “manual”
displayed. The selection of the data storage location is prompted as shown below.

Select Storage R .
The display indicates that measurements exist in storage
< S01l=-used = ...

Use [= to cycle through the storage locations. INCLINEO saves up to 999 measure-
ments. Measurements may be stored in locations S 01 — S10. The data storage system
is such that any one location is able to store the maximum 999 measurements. As
the maximum number of measurements that may be stored in INCLINEO is 999, this
implies that it would therefore not be possible to store any other measurement in the
other storage locations.

Select Storage .
This display shows that presently, no measurements have
= 5 D 4 = frEE - been saved in storage location S 04.

After selecting the storage location to be used, press . The display as shown below

appears.

» -0.743

FPuzh HOLD to =awe OY-000



Press [ (HOLD) to take and save the measurement or press [ to exit.

After the measurement has taken place, the display below appears indicating that the
measurement has been saved in the selected storage location.

The 3 options available after measurement are “ok”, “retry” and “exit”. The required
option is selected using [ or &, then confirmed by pressing 2.

» When “ok” is selected and confirmed, the measurement is saved.

» When “retry” is selected and confirmed, measurement is repeated.

» When “exit” is selected and confirmed, measurement is abandoned.

The memory submenu item “auto” is used for the automatic recording and saving of
a definite number of measurements. The submenu item is accessed using [& or

while in “Memory”.

With “auto” displayed, press . The selection of the data storage location is
prompted as shown below.

Use or 5] to cycle through the storage locations. Select measurement storage
location by pressing . This prompts the display of number of readings to be taken.

19
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The number of readings to be taken then saved is set using (= or [5. After setting
number of readings required, press [il. The duration for each measurement is then
prompted as shown below.

Sample Time
= 005 sec =

Set the duration for each measurement using [ or 5. Press [ifl to confirm setting the
duration. The following screen appears.

The bottom right corner of the display shows the
h = 0 o ? 4 3 currently selected storage location [04] and number of
Push HOLD to zawve OY4-000 measurements presently stored in the location [000].
Press [=5 [HOLD] to start taking and saving set measurements.
q This display shows the current storage location [05] and
L = 3 - 2 D — number of measurements already stored in the location
Auta Measuring... 03-016  [016]

If a storage location has previously been used, it is important to note the number
of measurements previously saved in the location, as new measurents are @
recorded successively. This is important when viewing saved measurements. In Note
the preceeding example, the next measurement will appear as number 017.

The taken and saved measurements may be displayed using the memory submenu item
“view" which is accessed as described at the beginning of this section (Memory).

Memory
< view =

Press B with “view" displayed. The selection of the data storage location is prompted.
Use [=] to select the location where measurements to be viewed have been saved.

Select Storage
< 504 =used =



Press i to open the measurement storage location.

Use [ or [ to cycle through the saved measurements.

Backlight
This menu item is used to control the display backlight.

Pressing [ while in “Backlight” reveals the submenu items. Use [E or [ to cycle
through the available submenu items. Press [iil to confirm selection of the currently

displayed submenu item.

Used to switch the display backlight on

When selected, the backlight switches off

automatically after 30 seconds

When selected, the backlight switches off 21

automatically after 5 minutes

Used to switch the display backlight off

Used to exit the “Backlight” menu

The “Backlight” menu is exited by pressing & with “exit” displayed. The next menu
item is accessed by pressing £ to display the first menu item (Relative Meas), followed
by [ or B repeatedly.
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RF module

This menu item is used to turn wireless communication on or off.

Pressing B while in “RF Module” reveals the submenu items. Use [E or [ to cycle
through the available submenu items. Press [if] to confirm selection of the currently
displayed submenu item.

Used to establish wireless communication to a
PC. When selected the Bluetooth LED blinks

Used to turn wireless communication off

Used to exit the “RF Module” menu

The “RF Module” menu is exited by pressing [ with “exit” displayed. The next menu
item is accessed by pressing B to display the first menu item (Relative Meas), followed

by [ or B repeatedly.

The RF module complies with the conducted and radiated emission limits of FCC
rules part 15.247.

Device info
This menu item is used to display the device serial number, the firmware and hardware

Versions.

Note



With “Device Info” displayed, press i to display the first device information. Use
or 55 to cycle through the available device information.

Device serial number is displayed

Firmware version is displayed

Hardware version is displayed

Used to exit the “Device Info” menu

23
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Measurement methods

Absolute measurement

This method is used to determine the exact or absolute inclination of the surface

being measured.

To carry out absolute inclination measurements, INCLINEO needs to be levelled. For

high precision, the measurement process demands that the object to be measured

and INCLINEO be at the same temperature. The surface where the level condition is to

be set must be relatively even and rigid.

1. Place INCLINEO on the object to be measured and switch it on. The active
measurement is displayed.

2. Set the displayed value as close to zero as possible. Use the rotating inclinometer
assembly and the micrometer screw.

3. Press i to access the menu, then press [B or B to select the menu item
“Absolute Meas”.

24

b pRUFTECHIK
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. With “Absolute Meas” appearing on the display, press . The message
" 1. Angle Press ENTER to measure” appears on the display.
Press [ to start measuring.

6. Assoon as the measurement has stabilized, “ok” appears on the display below

the registered value.

Press [i to accept reading. The message “2. Angle Turn INCLINEO and press
ENTER to measure" appears on the display.

1
[r—

h-1"57'57"

measuring .

b pRUFTECHNIK

renA

25
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10.

11

12.
13.

With INCLINEO still in its original position, mark the current location to enable
INCLINEO be placed at exactly the same position for the reversal measurement.
Now rotate INCLINEO through 180°.

Align INCLINEO into place then press [l to start second measurement.

. After measurement has stabilized “ok” appears on the display. The system has

now been set for absolute measurements.

Press i to confirm setting the level condition.

With the submenu item “save” displayed, press fif to save the set-up. Readings
taken henceforth are absolute values.

For the second reading,
INCLINEO is rotated
through 180° and placed
at exactly the same

position as in the first

e \ : " reading
2. Angle K '

T heunEo 5
e e

(<]-] ]
.



Relative measurement

It may be necessary to know the relative inclination of different surfaces. This is carried
out using the relative measurement method.
1. Place INCLINEO on the selected reference surface and switch the system on.

It is recommended that the displayed value be set as close to zero as possible.
You may use the rotating inclinometer assembly and the micrometer screw.

2. Press [ to access the menu items. “Relative Meas”appears on the display (if not
use [ or [ to select it).

Press il to access the submenu items.

Use [ or [ to select “set zero”.

Press [ill to proceed to set the reference value.

o vk~ W

After measurement, the collected value is displayed. Readings taken henceforth

are relative to the reference value.

<Relative Meas >
+001.1266 deg

b pRUFTECHIK

| L -0.8656 deg
measuring ..

Relative Meas.
< setzero >

=

Note

27
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Measuring wide angles

[t may be necessary to measure surface inclinations that are larger than the inclinometer

capacity of 10°. Such measurements are carried out using the relative measurement

method, and are made possible by the system’s rotatable inclinometer assembly.

If INCLINEO is placed on a surface with an inclination greater than 10° and turned on,

“overflow” is registered on the display.

The rotatable INCLINEO
housing allows high
precision measurements
on surfaces with steep

inclination.

In order to carry out relative measurements the rotatable assembly needs to be rotated

to display a near zero value.

1.
2.
3.

To rotate the assembly, loosen it by rotating the locking lever anti-clockwise.
The assembly can now be freely rotated.

Use the micrometer adjustment screw to attain the near zero value. The nearer
to zero the higher the accuracy of measurement results.

b rroFTeCHNK

- 4 +0.0014

R nm el
\




4. After attaining a near zero value, press [l then use [ or [ to select “Relative
Meas".

5. Press [ to access the submenu items and use [E or [ to select “set zero”.
Press [l to confirm selection.

After set-up is completed, the inclinometer assembly must never be rotated. All
related measurements must be taken using only this set-up.

7. Now proceed to carry out relative measurements.

In this configuration, the system can be used to measure the relative inclination of
surfaces with any inclination with an increased accuracy.

=

Note

29
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INCLINEO ALIGNMENT CENTER PC software

Before using the INCLINEO ALIGNMENT CENTER PC software please familiarize
yourself with the ALIGNMENT CENTER PC software. Information relating to this
software can be found in the ALIGNMENT CENTER File Manager and Flatness
manuals which are available from your local PRUFTECHNIK Condition Monitoring

representative.

The INCLINEO ALIGNMENT CENTER PC software may be used to determine straight-

ness and flatness profiles of surfaces.

Creating a measurement file

1. After starting ALIGNMENT CENTER, select “File”>"New">"ALIGNMENT CENTER

flatness file”.

4% ALIGNMENT CENTER 1.7 Expert

ZiBixi

Ky

Eile | Edit  Yiew Tools Help
¥ oren -~
P - b Organise Measurements % Transfer Measurements
HE=IE
[l dese
= Frint Setup.
e =\ | 0Cal database
Delete
Rename
N New Folder
New Company prba
ExpOtE... Ermbo
Import e lant b
New Area &rnbo
Settings... Lrbo
gk New Maching Train
ALIGNMENT CENTER Bore alignment file
Restore.
aefrash device et aatrs ALIGNMENT CENTER Bore alignment template
ALIGNMENT CENTER. Flatness file
Recannect
————————————————— ALIGNMENT CENTER Flatness template:
@ Frsperics Alt+Engabe ALIGNMENT CENTER Shaft alignment file
Exit ALIGHMENT CEWTER Shaft alignment template
ALIGNMENT CENTER Straightness fie:
ALIGNMENT CENTER. Straightness template:
ALIGNMENT CENTER Tolerance file

Searching for conwersion. ..

s

Date Last Modfied

07.07.2000 13:31
01.07.2000 09,20
23,11,2009 09:03
03.07.2009 11:13
20.11.2009 16:04
20.11.2009 17:28

=

2

Note



2. Right-click the mouse with the cursor on the file name. Select “Rename” from
the pop-up menu that appears. Proceed to edit file name as appropriate.
B
le Edt Wew Tools Help
=K -

|ﬁ i o| Organise Measurements @Transf&rMeasuvemenls

S Local database (cornscted)

a E Local database
¥ Samples
¥ Tolerances

Mame /| Username Size | Date Last Modified
| ACE_cables Anthory.Odhiambo 16,7 KB 07.07.2000 13:31
| ALIGNMENT CENTER Flatnes... Anthony.Odhiambo 0 bytes 01.07 2009 03:29
| ALIGNMENT CENTER Flatnes... Anthory.Odhiambo 0 bytes 23.11.2009 09.03
Anthory.Qdhiarmbo 0 bytes  23.11.2009 09:33
| Flauride Bed 2D Anthony.Cdhiambo 9,3 KB 03,07, 2009 11:13
| Flauride bed inclination anthony.Cdhiambo 0 bytes 20.11,.2000 16:04
|dFlouride bed inclination Anthory.Odhiambo 15,2 KB 20.11,.2000 17:28
2l »

|

Info

Name: ALIGNMENT CENTER Flatness file (2)
Type: ALIGNMENT CENTER Flatness file
File Name: 8HTXCIT~ ACLevalign
Size: 0 bytes
Date Last Modified: Montag, 23. November 2009 09:33:17

Ready o Il Il ] 4

3. Double-click the file name to open the file. The template assistant appears.

The template assistant will not appear if the file has already been configured. In @

this case, the dimension screen will appear.
Note

Template assistant rE

Select type of measurement plane

Ok

O Circle | Ring

()File open
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4. Use the template assistant to configure file as necessary.

Template assistant E‘ Note that the distance

Enter dimensions For the rectangular measurement plane between the columns

must be equivalent
N

oo Takal width: Full length: to the length of the

200

_:_:__ : Raw interval: Distance columns: mounting base.

Ty

humber of rows: humber of
columns:

[ <Back || Finish |[ Cancel ]

5. When file configuration is completed, click the “Finish” button. The dimension
screen showing the configured grid appears.
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6. You are now ready to start taking measurements.

Taking measurements
1. Switch INCLINEO on and set the necessary measurement options as described in
previous chapters.



» Measurements are taken wireless using the USB RF dongle ALI 13.620. See
schematic below.

» Alternatively use the cable combination which includes the receiver cable @
ALl 3.581-2 and the INCLINEO USB converter ALl 18.400. If using the cable Note
combination, please refer to the cable connection diagram below.

Standard procedure — USB RF

dongle schematic

USB RF dongle
ALl 13.620

INCLINEO computer port

Receiver cable ALl 3.581-2

INCLINEO USB converter
ALl 18.400

Alternative procedure — cable

connection schematic
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2. Click the 'Measurement’ icon followed by the INCLINEO icon on the button bar.

. ALIGNMENT CENTER INCLINED™ - Geometrical Alignment 1.7 Flatness -olx|
Edit View Tools Help

A i a8 b ) 1
NidHa Q w @)= <9 Q8
[“Main [Main A B c o E

[cons: [coms [e=]] .

= | Ere | -
:

1
T
5

ét‘ "

3000

¢00 ‘n;}qiann ‘n;}qiann ‘n;}q
12000

1875

Tgrs

ax

[l |

Std Dev,

Statistcs (Y)

Ready & I

|G e conner riand

3. Click the search button (3) located on the ‘Main sensor’ frame. The ‘Sensor

connection’ display appears.

Sensor connection

x|

Bluetooth——

I FRIUFTECHMI

Test |

—Serial

Search |

L6]¢ |

On clicking the search
button marked (3)
above, the message
‘PRUFTECHNIK’ should
appear in the box
below ‘Bluetooth” as
shown opposite. This
indicates that the USB
RF dongle has been
detected.

4. Click the Bluetooth search button to scan the neighbourhood for INCLINEO

Bluetooth.

However, when using the cable combination, click the serial port search button.



5. If INCLINEO Bluetooth is detected, its serial number is displayed. If using the
cable combination, “PRUFTECHNIK - USB Port” will be displayed.

Bluetooth: INCLINEO 73630127 Blugtooth

: Kommunikationsanschluss
PRUFTECHNI
Search
Teest

Serial

Bluetooth

I PRUFTECHNI
Search
Test

Serial

Search Search

F x

LIFTECHMIK - LIS Port

oK

O
In example 5a, wireless communication via Bluetooth has been selected. In 5b @

the cable combination has been used. Note

6. Depending on method used, click either the displayed serial number or
“PRUFTECHNIK - USB Port” then the ‘OK’ button. This information is then
transferred to the ‘Main sensor’ information box.

— (o]
DBl et yew Toos tep
0 ‘ N Y-S M
2] d gl |0 e -
d gl ®
2 X emery 2 x
Main Main B ¢ D E
10— -O— -O— ~O— "~
Bluetooth: INCLINEO 72 o 5 .
I [l L] X
Connect | Comect: | ) *
[ Msasuremen: Memor 1575
angle
3 7500
T T
1875
N +
T T
1875
50— “O— O— —O— <«
2500 B4 250,0 $1€ 2500 B¢ 2500
————— 1000,0
Reference sensor
L] -
Connect
Statistics ()
Ready fm I I y

7. Complete Bluetooth/cable connection by clicking the ‘Connect’ button in the

‘Main sensor’ frame.
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met =18Ix]
: X - = "
el aaw0eee5m= &% ¥
Messurement £ 2 X Hemory
[ Mainsensor [ Mainsenser
Blactooth: INCLINED 72 EIE
I i L |F — &
1875
+ 7500
1875
1875
2500 Bld 2500 S1 2500 Bf 2500
10000
Statistics (V)
Reacly m I I y

8. Place INCLINEO on the grid marked on the surface to be measured. Place
INCLINEO so that the red tip of the handle points in the direction that measure-
ment will be carried out with the display in view. The direction of measurement
is clearly shown with the INCLINEO ALIGNMENT CENTER PC software.

ﬁ-

The direction of
INCLINEO on the grid
may be changed using
a right mouse click.
Note: INCLINEO right
mouse direction
change is not recom-
mended and if at all
used, measurement
should be only in
absolute measurement

mode.



9. With INCLINEO correctly placed on the location to be measured, click the corresponding
position on the INCLINEO ALIGNMENT CENTER measurement screen.

- Chiorbed 2F - Geometrical Alignment 1.7 Flatness

e Bt Vew Iodk Hep
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e 12000 > _

-

[oodearmoam |-l

Staistics ()
S e matler

=
x

¥ o]

e
Std.ev.

10. Allow the measurement to settle. This is indicated by the standard deviation value. As
soon as a stable value is attained, click the “Take point” button to take measurement.

The recorded value takes the two adjacent points within an axis into consideration.

11. Repeat steps 8 through to 10 for all necessary measurement points progressing through
the grid in the specified direction.

'~ Chlorbed 2F* - Geometrical Alignment 1.7 Flatness —iox|
B &t Yew Ios Heb

al

37
S I The taken measure-

% ment points appear
1600 in grey.

R — _ _ _ _ _ ; 5 | _>l_|
‘Statistics (¥) ax
Comnect
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0,000 deg ] 501 0,00

[ ¥ fom1 |

Ready fom I 3 AGWENT ceVTER Fnd. |
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Evaluating results

After measurement has been completed, click the ‘Results’ icon to evaluate the results.

etrical Allgnment 1.7 Flatness (o]

D He Et Vew Took bep -'—.\'\

B ErT Y O T Res

s

= — A 8 c 0 e F 2 H

Reference

. i All positions where
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e ax 0= 020202000 measurement has

=020 =0 =0 =0 =0 been taken appear

e grey but results cannot

Tolerence. 5 x
eceeame

ST < <l S > ST

I auto Tolrance (2) [~

be displayed due a

missing reference

7{ —& —& — @ —&
i i o
[ J
[ ]
[ J
[ J
[ ]
[ J

e e o o o o o value. The value is
Statistics (). 8 x 12000
—— — )
T — entered as described
St = below.
ety [ — T

To be able to interpret measurement results, any one single measurement point within
the grid has to be assigned a specific value. This arbitrary value is used to convert the
angles measured into a height measurement. To enter the value, proceed as follows.
1. Right-click the chosen measurement point. A pop-up menu appears.
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Peaicpeak
Average
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2. Click the menu item ‘Manual measurement’. Enter the arbitrary value in the
value box marked Y. This value could be the actual height/depth of the selected
measurement point.



Manual results enktry x| The reference value

~ Position of 0.3 is entered at
Column: IB Lo I 1 point B1.
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¥ EE
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3. Click the ‘OK’ button to integrate the value into the measurement.
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After the arbitrary value has been entered (2) above, the results may be displayed in
2D and 3D formats.
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4, Chlarbed 2F* - Geometrical Alignment 1.7 Flatness
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Using a Bluetooth-enabled PC for INCLINEO connectivity

PRUFTECHNIK Condition Monitoring recommends use of the USB RF dongle
ALl 13.620 for Bluetooth connectivity between a PC and INCLINEO. If using a PC
with Bluetooth capabilities, the PC Bluetooth Manager is used to acquire wireless

connectivity.

In such instances, the ‘Authentification Request’ window will appear. Enter the

pin code “blue”.

Bluetooth Manager - Bluetooth-Sicherheit

Bluetooth-Schiuissel (PIN}

[Falls das Feld leer bleibt, wird die Standard-PIN werwendet. )

Gerdt anfordern
Blugtooth-Gerateadresse:

Blugtooth-Geratename:

00:17:91:03:11:95
INCLINED 73630143

&bbrechen |




Appendix to INCLINEO ALIGNMENT CENTER software

This appendix provides information about certain aspects of the PC software that @
may not be regularly applied but may prove useful to the user.
Note
Default measurement screen

The screen below shows the default configuration of the measurement screen when
the INCLINEO function is selected.

& Conveyor belt line 2 - Geometrical Alignment 1.7 Flatness (ol x|

40w 0 =we
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COM 5 . 500
Connect 500
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r—mnp Bl 150,01 bl 160,0 -Diet- 1500 i 1500 -1

« 00,0 >

Tk it |
< )

[ Reference sensor ‘I Id
r G
B ]

Mazinum
Angle

2 Peakcpeck.
Average
Std.Dev,

Sek reference marker

Resty m I [ Auwenrcee]| |

In the default configuration, the ‘Measurement’ and ‘Memory’ panes overlap. The
panes may be positioned at any selected location by clicking the appropriate tab and
holding the mouse down. The panes may be docked at the positions that turn light
blue when the cursor goes over the respective docking guide.
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In this example, the
‘Memory’ pane can
be dragged to the
location highlighted
light blue and docked
by releasing the

mouse button.

All measurements
stored in INCLINEO
are displayed in the
‘Memory' pane. In
this example, the first
measurement value
stored is storage
location 1 is diplayed
in the ‘Angle’ box.
The value stored was
0.001°.

The memory pane is used to display all measurements that have been stored in
INCLINEO. To display the readings, follow steps 1-7 as described in ‘Taking measure-
ments’ starting on page 31. However use only the buttons on the ‘Memory’ pane.
When connection is established, the message “Successfully connected” appears in
the 'Angle’ box.



Auto-routing

The auto-routing function enables the intelligent and automatic selection of the next meas-

urement point. Auto-routing can be activated at anytime. To activate auto-routing select
‘Tools'>'Options’>'Auto-routing’.

Choose a cateqarie

Ise

Auto routing

< Lits
R
3D
- Resuk

£ INCLINEO measurement Automatic f
INCLINED measurement [V Activate automatic Flow
| Mutorouting & Constant diection
) Report
Header and Footer " Alternating direction
- Content Direction Lower leFt to upper right | The ‘Direction’ drop
Landusge et ich
Style Lowser right to upper left

pper leftto lower right down menu shows
Upper right to lower Ieft

the available turn-by-

turn directions.

ok | cadd | ey |

Auto-routing is activated by checking the ‘Activate automatic flow’ box, and can be further
defined in terms of the turn-by-turn directions.

Al A2 A3 A4

B1 B2 B3 B4

» Constant direction implies that measurement will always be taken in the same direction:
Al —> A2 — A3 —> A4 —>B1 —>B2—>B3—> B4

» Alternating direction implies that measurement direction can be changed:
Al —> A2 —> A3 —> A4 —> B4 —>B3 —> B2 —> B1

43
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INCLINEO technical data

INCLINEO high precision inclinometer ALl 18.201

Measurement range
Resolution

Limits of error at
calibration [Ta =22°C]
Limits of error at
measurement [Ta =22°C]
8-hour zero-point drift
Digital Filter/Average
Temperature range

Display

User interface

Wireless communication
External interface

Power supply

Battery status indicator
Data storage
Integrated RF module

USB RF dongle ALI 13.620
PC interface
Temperature range
Dimensions
Antenna
Transmission power
Details

+10°

0.0003° [1"]

0.005% full scale

0.03% read out

0.005% full scale

0.06% read out

0.04% full scale

3rd order with 0.3/ 1/ 3 Hz options

Storage: -40°C to 85°C

Operation: -10°C to 60°C

LCD display, 132 x 32 pixel with LED backlight

Three key operation

Embedded RF module with LED indicator

RS-232 (serial) for computer and sensor

Connector for dial gauge

2 AA batteries

3 LEDs

Up to 999 measurements

Antenna — integrated

Transmission power — 20 dB max.

Complies with part 15 of the FCC rules. Operation is subject to following
conditions:

- Device must not cause harmful interference

- Device must accept any interference received, including interference
that may cause undesired operation

This transmitter is considered as mobile device and should not be used
closer than 20 cm from a human body.

Contained transmitter module — FCC ID: POOWML-C40 / CE: CE0678(D

USB 2.0 compatible
-40° C to 85° C
68 x 25 x 13 mm
Integrated
19 dBm
Complies with part 15 of the FCC rules. Operation is subject to following
conditions:
- Device must not cause harmful interference
- Device must accept any interference received, including interference
that may cause undesired operation
This transmitter is considered as mobile device and should not be used
closer than 20 cm from a human body.
Contained transmitter module — FCC ID: QOQWT41 /
IC: 5123A-BGTWT41
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Symbol

00621 0038
Philips cross
screwdriver 7
00739 1056
allen key (3.0 mm) 7
90022
AA-size battery 7

A

Absolute inclination 24
Absolute measurement 15, 24
ALl 3.581-2 8

receiver cable 33
ALI9.182.G 7
ALI9.183.G 7
ALl 13.620

USB RF dongle 6
ALI 13.700 CD

ALIGNMENT CENTER CD 7
ALl 18.000

INCLINEO standard package 6
ALl 18.200 6
ALl 18.201 6
ALl 18.400

INCLINEO USB converter 33
ALl 18.500 6
ALl 18.500-M

magnetic foot 8
ALI 18.501-150

grooved mounting base 6
ALl 18.502-150

prism-shaped mounting base 6
ALI 18.800 7
ALIGNMENT CENTER PC 30
Auto-routing 43

B

Backlight 21
Batteries

replacing 13
Battery

compartment 13
Battery compartment 12
Battery status LED indicator 12
Bluetooth-enabled PC 40
Bluetooth LED indicator 12

C

Calibration accuracy 10

Calibration certificate
ALl 18.290 8

CE compliance 9

D

Data storage
hint 10
location 19

Default measurement screen
PC software 41

Device info 22

E

Evaluating results 38
External interfaces 12

F

FCC rules
part 15.247 22
Filter 15
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H
Handle 12

INCLINEO connectivity
Bluetooth 40
INCLINEO package
grooved mounting base
ALl 18.001 8
prism-shaped mounting base
ALl 18.002 8
three-point mounting base
ALl 18.003 8
INCLINEO USB converter
ALl 18.400 8
IP classification 9

L

Labelling 10
Locking lever 13

M

Measurement base 12
Measurement units 16
Memory 18

Memory pane 42

Micrometer adjustment screw 28

Micrometer screw gauge 12

0]
Operating keys 12

P

Pane
overlap 41
Pin code 40
Power
AA size alkaline batteries 13

R

Receiver cable

ALl 3.581-2 8
Relative base length 16
Relative measurement 14, 27
RF module 22

Rotatable inclinometer assembly 12

S

Safety symbols 9
Storage 10

Storage location 20
Storage locations 18

T

Technical data 44
Template assistant 31

U

Unit

arcsecond 16
degrees 17
gon 17
milliradian 16
USB RF dongle
ALl 13.620 33

W

Wide angles
measuring 28
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